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Information for New Users.
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What is LatticeMaker?

LatticeMaker can be used with Ball & Stick,Chem-3D and MacMolecule to help in
the production of images of large bulk structures or super-structures of crystal
lattices.

System Requirements.

LatticeMaker uses colour pickers to set the colours of Atoms to be used in
MacMolecule and Ball & Stick. For LatticeMaker to be fully functional Color
QuickDraw and an 8-bit monitor must be present. If you have only have a B/'W
machine/monitor and are using 6.0.4 or later you will still be able to use
LatticeMaker but all of the colour choices will be dimmed. LatticeMaker is System
7.0 friendly.

Installing LatticeMaker.

As you are reading this file you must already have unpacked all the files. The
LatticeMaker Folder and Application can be anywhere on a hard-disk or floppy.
However, for it to run you must place the LatticeMaker Preferences file into the
system folder if you are using System 6.0.x or into the Preferences Folder in the
System Folder if you are using System 7.0 or later. If the preference file is missing
LatticeMaker will make one and place it in the correct location.

Place anywhere on disk

Lattice Mak'e-r' 2.5

ata’ |
13l Place anywhere on disk. For example inside above folder.

LatticeMaker 2.6
[ I
BELFs Place in System Folder or Preferences Folder.

LatticeMalier Preferences

Menus and Dialogs.

This next section describes the main features of the menus and Dialogs that you
will find in LatticeMaker.

Lattice Maker 2.6.0  4/18/21 2
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The File Menu.

m Edit Build
Open... 30
Linge XL

Bapa Dalaurs ®BS

Preferences...

Ouit 30
Use this menu to manipulate unit cell files. The Open... Item will let you select a
unit cell to read into LatticeMaker. The format of these files is described later. The
Close item becomes active if there is a file currently open and closes the file and
removes all the windows. The Save Colours item becomes active if you have made
changes to the colours of any of the atoms and have enabled the save colours
preferences. (See the next section). The Quit item does the obvious and needs no
explanation.
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el : LatticeMaker Preferences w2 6.0
iy
Remember... MacMolecule Output Options
[<] File Type. (@ Wire Frame
<] Window Positions. (_ Ball and Stick
{_) Space Filling
Save New Colours...
(<] In Pref's file. [ Stick Colour ]
(<] In Input file.
[<] Show Splash Screen

Choosing the Preferences... item from the File menu brings up the dialog box
shown. This allows you to choose which parameters you want LatticeMaker to
remember when you quit the application. The file type item will remember the file
type that you are currently using. If this is not enabled then LatticeMaker will use
Ball and Stick Moldat as the default file type. The next item allows you to choose
wether to remember where the windows are on the screen next time you run
LatticeMaker. The next two options are used to specify where the new colours are
saved. This allows the new colours to be saved in the Unit cell file but not in the
Preferences file so that you may have the same atom with different colours in two
or more Unit Cell files. The next time that you open an input file with stored
colours, these colours are read instead of those stored in the Preferences file. If
there are no stored colours then the Preferences file is used. The options on the right
hand side are for those people who use MacMolecule. It allows you to choose the
default type that LatticeMaker will create for files that are read into MacMolecule.
You can choose the stick colour for the bonds in ball and stick mode by clicking
stick colour. The current colour is shown graphically in the small window.

The Edit Menu.

This is a standard edit menu and has no function in LatticeMaker itself and is there
purely for the support of DA’s for those people who are still in the dark ages and
using System 6!

The Build Menu.

Lattice Maker 2.6.0  4/18/21 .4
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Lattice Size...
Output File Type... §
Bonds...

This menu is used to control the size of the lattice and the type of output format that
you wish to produce.Use the Size... item to select parameters which describe how
the lattice will be built up and how big it will be.Use the Output File Type... items
to define the type of output that you want LatticeMaker to produce. Currently four
types are supported, but this may be extended subject to demand, and these are
described later. The Bonds... item 1is used to choose how you want LatticeMaker to
build bonds between the atoms in the Lattice. Use the Build... item to create the

lattice when you are happy with all of your chosen parameters.
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The Size... Dialog.

Lattice Parameters w2 B0 E

H o1 Alpha [90.00 =
¥ |1 Beta 90.00 =
z 1 Gamma |90.00 ;
Unit Cells Crystal Axes (°) g

2]

A |4.59 z

B [4.59 Wi .
C |2.96 s

Cell Constants (A) =

This dialog box is used to set up the size of the lattice that is produced by
LatticeMaker and appears when the Size... item is chosen from the Build menu.
The number of units cells that you want to build in each of the x,y and z directions,
the unit cell parameters a,b, and ¢, and the angles between the crystal axes can all
be set in this dialog. The angles between the axes are defined such that the a-axis of
the crystal is parallel to the x-axis in cartesian space, and the ab plane or (001)
crystal face is parallel to the xy cartesian plane.

The Output File Type... Dialog

Lattice Maker 2.6.0  4/18/21 ...6
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This dialog allows you to choose one of the four types of output file. The only type
that really needs explanation is Ball & Stick + resources. This output format adds
specific resources to the output file so that when it is read into Ball & Stick all of
the atom types will be set up and require no extra work defining new types. If Ball
& Stick + resources or Mac-Molecule is the chosen type and an 8-bit colour
monitor 1is present then a window showing the general appearance of the atoms will

appear.

v f.i

Please select a format for the output file

(") Ball & Stick (moldat)
@ Ball & Stick + resources ?,E.?
)y Mac-Molecule 25

() Chem-3D

Lattice Maker 2.6.0
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The Bonds...Dialog.

Ti 4] L ) Maximum P
0 0 Bond Length 2.3 S
{3 No Bonds
- | = Nearest Meighbour bonding.
o T q q

[ Use Atom Filters.
Atom: Bond to: [ lonic Radii ->Bond Length

Max Coordination number = 8

This version of LatticeMaker will optionally create bonds between atoms in the
lattice. The methods used by LatticeMaker to create bonds are flexible enough to
cope with most bonding situations. To add bonds to the lattice select Nearest
Neighbour bonding and choose one of the following methods. For a lattice which
contains only one atom type (for example Si) the simplest bonding scheme is to use
nearest neighbour bonding, with a suitable distance selected in the maximum bond
distance box. All atoms closer than or equal to this bond distance are bonded
together. The maximum bond distance is limited to 10A (as no real bonds would
ever be this long). The maximum coordination number of each atom is currently
fixed at 8 bonds. If the number of bonds exceeds 8 then any extra bonds are
ignored. If you wish to build a lattice which contains more than one atom type
where only hetro-nuclear bonds are allowed then the atom filters option allows the
selection of allowed bonding combinations. Select the atoms which you wish to
make bond to, from the left hand list. Then select from the right hand list (shift-
clicking if necessary) the atoms you want to bond to. After you have made the
selection press Save to remember your selection. Repeat this for all of your atoms.
To make this option active you need to check the Use Atom Filters item. The final
option which allows more control over bond formation is to use the ionic radii as a
bond distance parameter. When this option is chosen the value in the bond length
text box is ignored, and a value equal to the sum of the radii of the two atoms to be
bonded is used as the bond distance. The radii of atoms can be changed by using the
Ball and Stick colour picker or by editing the settings in the preferences file with

ResEdit. (see later for details of customising resources)
Lattice Maker 2.6.0  4/18/21 ...8
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The Build... Window.

Lattice Maker Status

I'?li;? e i

421 g 258 SO 758 1008
5aving file : New Lattice
# "' to Cancel
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This window will appear while LatticeMaker is calculating and saving the file to
disk. If you wish to stop the program before it is finished just press the 36 and °.” at
the same time. If you are calculating a very large file it may take some time for
LatticeMaker to respond.

The File Info Window.
File Info
Input File : Ti0Z Clnput) g
Unit Cell Parameters
Atoms in Unit Cell =5
a=45%% b=459% c=295h
o= 20.00° P=9000° y=90.00°
=2=1 Y =1 =1
Atom Coordinates
No. Type x y z
1 Ti 0000 Qo000 O0.000
2 Ti 0300 0500 0500
3 0 0333 0333 0.000
4 o 0ecs Q665 0000
3 0 04167 0833 0300
& 0 023z 0467 0500
File type MAC-MOLECULE.
Number of Atoms types =2 E

This window shows the status of the current file and display information such as the
cell constants a,b, and ¢ and the number of cells in the x, y, and z directions. It also
shows the positions of the atoms in the unit cell as they were read in from the unit
cell file. At the bottom of the window is information about the current output File
type and the number of different atom types that are present in the file. Currently
LatticeMaker can handle up to 10 different types in each file.

This info Window scales as the number of atoms in the file changes so that it is
always just the right size. If the list is too long to fit on the screen then the scroll
bars will become active.

Lattice Maker 2.6.0  4/18/21 ...10
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The Atom Colours Window.

=— Atom Colours =— Atom Colours

0 Titanium N Titanium
0 O=ygen ﬁ O=ygen

[Click in balls to change calours) [Click in ballzs ta change colours)

Mac-Molecule Ball & Stick + resources

If either the Ball & Stick + resources or the Mac-Molecule file formats are chosen
then one of the windows shown above will appear. This windows is updated to
show the currently chosen colours. The Color menu that was present in older
versions of LatticeMaker has been replaced by this Colour Window. Clicking in the
balls will bring up either the standard colour picker or a custom picker if the file
type is Ball & Stick + resources.

Lattice Maker 2.6.0  4/18/21 L1
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The Ball & Stick Colour Picker.

Radius 1.20 | f

1 &
Shade 1 [95 |4 Ja

Shade 2 |49 |%

Ball & 5Stick
5ettings.

Color 1|« Blue 0xygen

Color 2|« Black | Cancel |

This picker allows you to do more than just set the colour of the ball but also the
diameter of the atom as it will be drawn by Ball & Stick. The two PopUp menus
choose the colours of the ball and the lines used to draw the outline and axes. This
Dialog is of a similar type to that used by Ball & Stick but has been simplified here.

File Formats.

There has been a change in the file format since previous versions. LatticeMaker
will still read in old files but will also support the new format which includes
comments and lattice angles. The new format is shown below.

V2 This indicates that the file is version 2.

NAtoms

a b c

xlen ylen zIen

alpha beta gamma

X y z type
Xn Yn z, typep,

Where a,b,c are the unit cell lattice constants. These values are editable within the program. alpha,beta and gamma are the
lattice angles between the axes. For an orthogonal system these axes are all 90°. Xjans Yjen & 2| are the number of unit

cells in each of the x-y and z directions. These are also fully editable within the program. x, y, & z are the unit cell
coordinates of the atoms in the unit cell. The type is as specified by Chem-3D and you will need to know these

Lattice Maker 2.6.0  4/18/21 12
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parameters even if you are using Ball & Stick or MacMolecule or wish to define your own lattices. You will find a
list of the types in the Appendix. LatticeMaker will output in four formats. Either Ball & Stick (moldat), Ball and
Stick +resources, Chem-3D (cartesian) or MacMolecule (space-filing). See the example input files for example of
how to use comments (this is text starting with a semicolon (;)).

If the program doesn't understand an atom type that it is specified, or you wish to have balls to represent multi-atom
substituents, then you can add this new type to the program by using ResEdit, however most users should find this
unnecessary as LatticeMaker knows of all of the element types defined in Chem 3-D (See Appendix for more
details ). If you do find an unknown atom or wish to add your own then follow the instructions for customising types
in the next section.
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Customising Types in LatticeMaker.

All the information about each atom type is stored as a STR# resource in the LatticeMaker
Preferences File. They are made up of 10 strings in the following format.

1).  Ball & Stick or Chem-3D String eg. Ti, Si, or O.

2).  MacMolecule Character. eg T,S( Limited to only one letter by MacMolecule)

3).  String representing the atom radius in Angstroms. Used by MacMolecule and B&S.
4).  String representing a Red value for the atom colour Used by MacMolecule.

5).  String representing a Green value for the atom colour Used by MacMolecule.

6).  String representing a Blue value for the atom colour Used by MacMolecule.

7). Anumber between 1 and 8 which represents the colour used for the Ball in B&S.

8).  Anumber between 1 and 8 which represents the colour used for the lines in B&S.

9). A number between 0 and 100 which represents Shade 1 used by B&S.

10). A number between 0 and 100 which represents Shade 2 used by B&S.

The ID of the STR¥ resource is the same as the atom type, so to define a new type make a new STR resource
containing the relevant information for the new type.

***IMPORTANT NOTICE***
Any custom resources created for older versions of LatticeMaker (pre 2.5) will have to be updated to include the
extra resources of they will fail to read in correctly and a file loading error will be produced.

Most of the RGB values for the atoms are set to zero in the resources but can easily be changed using ResEdit. The
other way to set the colours of the atoms is to by clicking in the balls in the Atom Colour windows.

Known Limitations of LatticeMaker.

At the present time MacMolecule (currently v1.7) only supports single characters to
represent atom types. This make it difficult to represent a range of molecules

without editing either LatticeMaker or the output files. So for instance CaCO3 could

not be represented as Ca for Calcium, C for Carbon and O for Oxygen. We have to choose,for example, C for
Calcium, X for Carbon, (as we cannot use C), and O for O.
Hopefully this limitation will be removed by a later version of MacMolecule. (Please!)

Although LatticeMaker will run without problems under System 7.0 it doesn't support things such as Apple Events or
Publish and Subscribe (and probably won’t as I cannot think of a use for them).

Possible additions to LatticeMaker will depend on the kind of response I get from users.
These may include:-

1). Full text editing support for creation an editing of Unit Cell files within the program.

(This may happen when I have figured out TextEdit.)
2). A built in Atom Editor to add new file types without having to resort to ResEdit (which is still very
effective.)
3). Support for more input formats such as those from crystallographic databases.

This would incorporate symmetry operations to build lattices from the most unit cell descriptions (as
are normally described in papers and journals).
4). What ever you might suggest.

Lattice Maker 2.6.0  4/18/21 ...14
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Additions Since Last Release.

v25.0
Made Preferences more robust and flexible by having a Preferences file which
stores all the colours and current preferences.

Added extra options to the Preferences Dialog to allow new colours to be saved in
either the Preferences File or in the input file.

Opening a file now causes the input file resource fork to be searched for any STR#
resources containing colour and other information before the Preferences file is
searched. This means that colours can be stored more conveniently in the input file.

Enabled the Close item in the File menu and removed the New item which I
thought I may use but have decided I probably won't!

Enabled the Save item and renamed to Save Colours. This will save the current
colours assuming that there is a file open and that the relevant Preferences are set.

Added better support for Ball and Stick files by writing specific resources into the
output file. In conjunction with this I have added a custom colour picker for Ball
and Stick atom types.

Removed the colour menu item as the colour choice is now better served by the
new interactive Atom colour windows.

v2.5.1

Fixed a bug which caused LatticeMaker to report an error if an input file was used
that didn’t contain a valid resource information. This unfortunately made it
impossible to create new files!

Added some cosmetic enhancements such as animated cursors during time
consuming operations, and extra icons for some of the dialogs.

v2.6.0
Extended the input file format to include angles and comments.

Enhanced the Info window to reflect the addition of angles to the input file. Now

Lattice Maker 2.6.0  4/18/21 ...16
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has scroll bars if the number of atoms will not fit in a window that takes up the full
height of the screen.This allows all of the coordinates to be checked to make sure
they have read in correctly. (This window will be fully resizeable in a later version
of LM)

Added bonds in the output file. The bond creation methods are very flexible and
allow almost all possible bonding senarios.

Added an option to the prefs which allows the splash screen not to be showed at
start up. and extended the prefs resource to include information about the
MacMolecule bonds

colour and also the current output setting (either WF BS or SF).

Extended the output of MacMolecule format files to include a message at the end
for

display in the text box of version 1.7 upwards of macmolecule. This message is
stored as a TEXT resource so it can be edited by those willing to wield ResEdit.

Added Notifications. If LatticeMaker is switched into the background while doing
some calculations then it will use the Notification Manager to alert the user if it is
still in the background when the calcs have finished.

Lattice Maker 2.6.0  4/18/21 .17
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Removed problems with strange cursors if another application was switched in and
out. LatticeMaker now resets it’s own cursor.

Despite the problems that it can cause LatticeMaker still works with both System
6.0 and 7.0. I will try to hold out for as long as possible before abandoning System
6.0!

Thanks
Thanks must go to all of the following.

Dr. Norbert Miiller author of Ball and Stick for supplying me with a description of
the Ball and Stick Moldat format and also for information about Ball and Stick
resources. Cherwell Scientific Publications Ltd for the gratis copy of Ball and
Stick. My Ph.D thesis is now full of wonderful models!

Dr. John Pilling for pointing out some of the bugs and providing the maths for the
non-orthogonal calculations and also providing some of the unit cell files.

Also all those of you who have send messages of support and comments on the
program and given me the incentive to continue.

Disclaimer and Copyright Notices.
LatticeMaker 2.6.0 © 1992. All Rights Reserved Peter J. Hardman.

I give you, the user, a licence to use this program free of charge on any machine either singly, or on a computer
network for a limited period of 14 days. After this time you may keep the program on payment of the Shareware fee
($30/£15) otherwise you must destroy all copies. It may be freely distributed by any means, including electronic
bulletin boards providing the following conditions are not broken.

(1) That no fee is charged for this program (except for online charges).

(2) That the program has not been altered.

(3) All documentation and example files are include with the program.
I retain all rights to the program and as such you may NOT:

(1) Modify,translate, decompile of disassemble the program or alter thedocumentation.

(2) Remove any Copyright or Proprietary notices, labels or marks in either the program or documentation.
The software is provided on an as is basis, with no warranty of any kind. The author excepts no responsibility for
damages arising from the use of this program under any circumstances. Future releases will be made available via
(Info-Mac) sumex-aim.stanford.edu, MacSciTech (ra.nrl.navy.mil) or by email to registered users.
Any files that you create with this program may be used for any purpose. Please mention that the files were created
using LatticeMaker © P.J.Hardman.

Correspondence Comments and Questions
Any correspondence about LatticeMaker © 1992 should be sent to:-

Peter Hardman.
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Chemistry Department,
Manchester University,
Manchester M13 9PL.
England.

Phone 044 61 275 4640
Fax 044 61 275 4598.
email  hpj%cxa.dl.ac.uk@nsfnet-relay(prefered).
or hardman%v2.cgu.mcc.ac.uk@nsfnet-relay.

Lattice Maker 2.6.0

4/18/21

...19



gsave
.99 setgray

150 100 moveto

/Helvetica-Bold findfont 75 scalefont setfont
55 rotate

(Lattice Maker 2.6.0) show

grestore

I welcome any comments about the program, it's limitations and possible future enhancements. Future releases will
be made available via (Info-Mac) sumex-aim.stanford.edu, MacSciTech (ra.nrl.navy.mil)
Thanks for your support.

Have Fun.

Peter Hardman 1992.
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Appendix

This is a list of the atom types from Chem-3D that LatticeMaker recognises. This
list is derived from Chem-3D plus 2.0.1 © Cambridge Scientific Computing 1986-

89.

Ag
Al
As
At
Au

B

Ba
Be
Bi

Br
Csp
Csp2
Csp3
Ca
Cd
Cl
Co
Cr
Cs
Cu

F

Fe
Ga
Ge

H

Hg

1

In

Ir

K

La

Li
Mg
Mn
Mo
N

Na
Nb
Ni

O Bridging
O sp2
O sp2
O sp3
O Terahedral
Os

P

Pb

Pt
Rb
Re

474
133
333
851
794
53

562
42

833
351
62

63

64

202
483
171
276
246
551
294
91

266
314
324
11

803
531
493
776
191
573
31

122
256
426
77

111
416
284
89

88
82
84
766
159
824
784
371
756
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Rh
Ru
S bent
Sb
Sc
Se
Si
Sn
Sr
Ta
Te
Ti
Tl

456
446
162
516
213
342
144
504
382
736
522
226
813
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\% 236
W 746
Y 393
Zn 303
Zr 404

For the more exotic atoms, or if you wish to use an atom to represent a molecule or substituent then create you own type and add

the STR# resources.
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